| ntroduction

This booklet is a companion to the A-level computer software - ‘L ancaster Particle Physics.
The software itself contains enough information to ‘ stand alone’, but this booklet coversin
greater depth the information and help pages contained within the program and it is

recommended that, where possible, both are used in conjunction.

The software package is designed for use by students studying A-level modulesin particle
physics. Itsmain aim isto allow students to conduct particle physics experiments, in the
classroom, via computer ssmulation (PC based). This booklet shows how to install and run the
program and takes the user through each exercisein detail. The students should already be
aware of most of the terminology and formulas, contained in the software, before starting the
various exercises. Where needed, additiona information and discussion is given and the
derivation of some formulas shown, making the booklet of use to both students and teachers.
However, if the user wishes to disregard this preamble then all the important formulas (those
required for each exercise) are shown boxed for easy reference. In places the software
introduces physics which goes beyond the A-level syllabus, this isintended to extend the

students' knowledge and stimulate discussions.

The five sections of this booklet correspond to the five ‘ Options' in the software, of which the
first four include exercises. It is estimated that each exercise will take a student between one
and three hours to complete, but thisisonly aguide. The actual time will probably be

influenced more by the teachers discretion and the availability of PC’s than student ability.

Section 1 coversthe exercise ‘Billiards which re-familiarises the student with the
conservation of energy and momentum in a non-relativistic system, i.e. when playing billiards
or pool. Section 2, ‘Particle Annihilation and Creation’, comparesi) stationary target
experiments with ii) colliding beam experiments and serves as an introduction to the following
options, which are all concerned with particle physics. Section 3, ‘Charged Particle Motion
in a Magnetic Field’, allows the student i) to make measurements of charged particle tracks,
i) to use their knowledge of the relativistic equations of the conservation of energy and
momentum to calculate the particle masses, iii) to identify the particles. Section 4, ‘Lifetime’,
simulates the decay of the neutral particle, the kaon (K°), into two pions (p*, p-). The student
can make measurements and use their data to determine i) the K° mass and i) mean lifetime.

Finaly Section 5, ‘ALEPH’, shows the students some real data from an ongoing experiment.
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Introduction

ALEPH isone of four detectors at CERN detecting the debris from high energy electron-

positron annihilations.

Computer Requirements:

‘Lancaster Particle Physics' isintended to be PC based. The minimum computer requirements

are:

Computer: IBM PC compatible 386, 486 or higher; with mouse.
Minimum 16 MHz CPU (33 MHz or higher recommended)

Memory: 4AMB (8MB recommended)

Video: VGA 16 colours, 640~ 480 resolution (or higher)

Operating System: DOS 5.0 or higher and Windows 3.1, 3.11 and Windows 95.

Sound: no sound card needed.

How to I nstall:

To ingtall your copy of ‘L ancaster Particle Physics
1. Insert the distribution disk into your A: or B: drive.
2. Start Windows.

3. Either: from the Microsoft Windows Program Manager, select Run from the File menu

and type:

a:setup
Or: run File Manager and open awindow for the distribution disk in your A: or B: drive.
Click on thefile:

setup.exe

‘Lancaster Particle Physics will now beinstalled. Follow the dial ogue boxes which ask you
in which directory you want the software installed. If you have no preference then the
installation program will create its own directory on your computer hard disk drive called

‘collisn’. Once ingtallation is complete a dialogue box will inform you; click the OK button.
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A window and program icon for ‘L ancaster Particle Physics' will then appear. Y ou can now

remove the distribution disk.

(Warning: During installation you may get a message box which says that file
A:\DDEML.DL _isaready inuse. Don't worry! If this happens click the OK button and the

installation will continue as normal)

To Start ‘Lancaster Particle Physics' double-click on the program icon with the mouse

pointer.

Navigating your way around ‘L ancaster Particle Physics

Upon starting ‘ L ancaster Particle Physics' you are presented with the Lancaster University
logo page. Click the OK button and the logo page disappears to be replaced by the window
shown in Figurel. Asyou can see this window contains a smaller window with text and four
command buttons. Thisis the start-up page for the exercise ‘Billiards'; the text describes how
to run the exercise and what to calculate. (Each new option/exercise starts off with atext

page and it is recommended that the student reads this before continuing)

=-| Lancaster Particle Physics B4l ‘E
Options Help

Billiards

> ELASTIC collizion hetween a moving
q ball fwhite) wih mass, m1 and a
stationary ball (red) with mass, mz= 3 Kg.
4| Click the Graphics button and then the
| Fire button to seethis.

> The data boxes show the angles that
the white and red hallz make with the
intial direction, after t*  collision; &, ¢
respectiv and the £ velocity of the

| white -

1 > Us your
3 know : of
e Text Window
ditor sident
1] wh

2 BEvwen your coeuidted walue for myin the
data box and press return to display the
| Anawver

= You can change the relative masses of
my and m: by clicking on the Option
huttons.  You can change the incident
velocity uy of the white ball by using the
zoroll har.  Experiment with  different
settings; calculating mass ma1 each time.
> To proceed onto the next graphics click
the Hext button. (See the Helpmenu)

¢ #Hack | Mext » | | Graphics
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Figurel ‘Text window’

The four command buttons are;

When you click the Graphics button a new window is displayed as shown in Figure ll. This
is the graphics window associated with the *Billiards' option. (Each new option/exercise
has a graphics window which can be opened by clicking the Graphics button in the text
window. Itisin these graphics windows that the smulations of particle interactions take

place)

=-| Lancaster Particle Physics B4l ‘E
Options Help

Billiards Billiards

> ELASTIC collizion hetween a moving
1| ball (ehite) with mass, m1 and a
stationary ball (red) with mass, mz= 3 Kg.
1| Click the Graphics button and then the
Fire hutton to see this.

4| 7 The data boxes show the angles that
o | the white and red balls make with the
intial direction, after the collision; &, ¢
4 | respedively, and the final velocdty of the
1 | white ball vi.

>Use this information, and  your
|| knowdedge of the  equations  of A 1o WAT X7
]| conservation of energy and momertum, LTI a:[j]']']'c'b XRI uldD“
to calculate the mass my of the incident
] | white ball.

]| = Erter your calculated value for myinthe
data box and press return to display the
1| Anawver.

= You can change the relative masses of
my and m: by clicking on the Option
huttons.  You can change the incident
velocity uy of the white ball by using the
zoroll har.  Experiment with  different
settings; calculating mass ma1 each time.
> To proceed onto the next graphics click
the Hext button. (See the Helpmenu)

| Exit |< ook | Next » | | Graphics

4-| | +| ul [mfz]): 3 & ml<m2

Figure Il *Graphics window’

When you click the Next button you move on to the next option/exercise and a new text
box appears. (All previous windows for the last option are automatically closed. In

essence each option or exercise isamini self-contained program)

When you click the Back button you move back to the previous option/exercise. In
‘Billiards the Back button is disabled and inoperative (appearing dimmed) because there
are no previous exercises. (Once you click the Next button the next option/exerciseis

loaded and the Back button is now enabled. Hence by clicking the Next and Back buttons
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one can move sequentialy, forwards or backwards, through the various sections of

‘Lancaster Particle Physics)

To terminate the program click the Exit button.

Note: the underline on the prefix character of the command buttons allows the user to either
click the button, using the mouse and mouse pointer, or press Alt-key (where key isthe

underlined character).

Alternatively by pressing the Tab key the user can move the keyboard focus from control to
control. You can easily recognise when a control has the focus: when a command or option
button has the focus, a dashed rectangle surrounded its caption; when a scroll bar has the
focus, its thumb starts to blink; when atext box has the focus, a cursor inside the text box
blinks.

When an object has the focus you can use the keyboard, instead of the mouse, to control this
object. With acommand or option button, pressing Enter/Return (or the space bar) has the
same effect as clicking the button with the mouse pointer. With a scroll bar you can use the

left and right arrow keys to move the position of the thumb.

If you have two windows open, as shown in Figure |1, you can move the window focus by
pressing Ctrl-F6, together. When awindow has the focus (its border is shaded) you have

accessto al its controls using the Tab or Alt keys as before.

Certain command buttons respond to the Esc key irrespective of which control has the focus.
These are the Exit buttons in the text windows and the OK buttons in the Help windows and
ERROR! dialogue boxes. For example if atext window had the focus and the Esc key was
pressed, the program responds as if the Exit button was clicked and so terminates.
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There is a second method for navigating through ‘L ancaster Particle Physics'. Instead of
using the Next and Back buttons one can click on the Options menu, displayed on the menu
bar of the main window as shown in Figure I1l. The program responds by dropping down a
list of al the options/exercises contained in ‘L ancaster Particle Physics. A check mark
indicates which option is currently open. Hence by clicking on an option one can ‘jump’ to
that particular section without having to go through the previous exercises. (Note: thisis
only recommended for experienced users of ‘L ancaster Particle Physics'; beginners should
work through each option, because each exercise is designed to follow on from the last) The

Options menu can also be used to terminate the program by clicking the option Exit.

=-| Lancaster Particle Physics | "l AE
Options Help

2+ Hun Ei"iardﬁ Billiards
Run Particle Annihilation P
Hun Motion in magnetic field
Run Lifetime

Run ALEPH

Exit

intial direction, after the collision; &, ¢
] | respectively, and the final velodty of the

| white ball vi.
> Uze thiz information, and  your
J| knowledge  of the  equations  of +

conservation of enengy and momentum,
]| to calculate the mass my of the incident
] | white ball.

> Enter vour calculated walue for iy inthe
data box and press return to display the
1| Anawver.

= Yaou can change the relstive masses of
my and m: by clicking on the Option
huttons.  You can change the incident
velocity uy of the white ball by using the
zoroll bar.  Experiment swith  different
4 | settings; calculating mass mi each time.

T GO

> To proceed onto the next graphics click Ootions
1| the Hext button. (See the Help menu) @_p_m1>m2
| Exit |< Hack | Hext > | | Graphics ‘Fire:! | | #] ul [m/s): 3 g m::ms
; W e femnEa ) bR o R i ml<m

Figurelll ‘Options menu’
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Lancaster Particle Physics

The menu bar also contains the Help menu. Clicking this produces a drop-down list of help

pages for each option, as shown in Figure IV. These help pages are very important because

they contain additional information on how to run each exercise, including hints and answers.

In some instances it may be beneficial for the user to read these pages first, before starting an

exercise.

=-| Lancaster Particle Physics

Options  Help
About Billiards

|| > ELASTIC
| ball  (white
o | stationary b
1| Click the ¢
4 | Eire button

Billiards

1| >The data  Ahout Lancaster Particle Physics
the white Sre——w—sme—rrsme— T

intial direction, after the collision; &, ¢
4 | respedively, and the final velocdty of the
1 | white ball v

>Use this information, and  your
knowledge of the equations  of

conservation of enengy and momentum,
to calculate the mass my of the incident
] | white ball.

]| = Erter your calculated value for myinthe
data box and press return to display the
1| Anawver.

= You can change the relative masses of
my and m: by clicking on the Option
huttons.  You can change the incident
velocity uy of the white ball by using the
zoroll har.  Experiment with  different
4 | settings; calculating mass mi each time.

T T

> To proceed onto the next graphics click
the Hext button. (See the Helpmenu)

| Exit |< ook | Next » | | Graphics

4-| | +| ul [mfz]): 3

Options
® mlym2
O ml=m2
O ml<m2

FigurelV ‘Help’ menu

Note: the Help pages for each option are only available when that option is open; the other

help options being disabled and appearing dimmed. To open a Help page click on the menu

title; thiswill open the help window as shown in Figure V. Click on the OK button to close

the help window. In the later optiong/exercises the help windows have more than one Help

page; these can be viewed by clicking the

corner of the window.

buttons found at the bottom right hand
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Lancaster Particle Physics

Options Help

Billi

About Billiards

= ELASTIC collision
ball  (white)  with 0
stationary ball (red) wi
Click the Graphics &
Fire hutton to see this
> The data boxes sh
the white and red b
initial direction, atter
respecively, and the
white ball v,

> Uze thiz inform
knowledge of th
conservation of enen
o calculate the mass
white ball.

> Enter vour calculste
data box and press r
ANEvEr.

= “ou can change the
my and m: by click
buttons.  You can o
velocity uy of the whi
zcroll bar. Experi

* Clicking the Fire hutton, with the mouse pointer, causes the
white hall to move on a collision course with the stationary red
hall.

= Lse the scroll bar to change the initial velocity of the white ball,
by clic king on the arrowe keys or by dragoing the central buttan.

* Click on the round Option buttons to select the relative masses
of the two balls;

my = ety has avariahle mass > 3 Kg and < 30 Ko,

My = e tmy has a fiked mass of 3 Ko,

Iy < ey has avariable mass = 001 Ko and < 3 Ko,
Femember my is different on each new firing sequence (except
when my = mg; its value will lie in the range specified by the
option huttons.

> MNote:  To obtain the Answer you must first enter your
calculated value in the data box {containing the flashing cursor)
and press return. The Answer will then be displayed in red.

* Click OK to continue, and then Eire for fresh araphics.

settings; calculating mass ma1 each fime. [
> To proceed onto the next graphics click
the Hext button. (See the Helpmenu)

T GO

| Exit |< ook | Next » | | Graphics Fire

4-| | +| ul [mfz]): 3

Options
® mlym2
O ml=m2
O ml<m2

FigureV ‘Help window’
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